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Abstrak 

 

Sudah sepatutnya guru harus memiliki empat kompetensi, meliputi: pedagogik, 

kepribadian, sosial dan profesional. Salah satu dari aspek kompetensi pedagogik adalah 

harus mampu memanfaatkan Teknologi Informasi dan Komunikasi (TIK) untuk 

pembelajaran. Jadi sangatlah perlu seorang guru untuk memahami berbagai strategi 

pembelajaran yang mampu mengaktifkan peserta didik dalam proses belajar dengan 

memanfaatkan media pembelajaran. Pemanfaatan media dalam pembelajaran dapat 

merangsang peserta didik dan membuat suasana pembelajaran menjadi lebih 

bersemangat. Salah satu media pembelajaran yang dapat memudahkan guru dalam 

menjelaskan materi dan memperkuat pemahaman dan ingatan pembelajar adalah media 

visual proyeksi berupa aplikasi PowerPoint. Namun demikian, pemanfaatan aplikasi 

PowerPoint selama ini oleh guru tidak memperhatikan aspek keefektifan slide yang 

dibuat, seperti: tidak menggunakan desain, posisi, warna, dan gaya slide yang standard, 

tidak menggunakan warna-warna yang selaras, dan tidak menggunakan efek, transisi, dan 

animasi selayaknya. Di samping itu, aplikasi PowerPoint oleh guru kebanyakan hanya 

digunakan untuk membuat suatu media presentasi atau bahan ajar yang bersifat satu arah 

saja (non interaktif), dimana pengguna hanya berlaku sebagai pendengar atau penonton 

saja tanpa terlibat aktif dalam proses pembelajaran yang ada dalam media tersebut secara 

mandiri.  Dengan gaya penyajian PowerPoint yang efektif dan berbeda dengan sedikit 

sentuhan kreativitas berupa pemanfaatan Macro VBA (Visual Basic Applications) akan 

membuat media presentasi yang biasa menjadi luar biasa dan interaktif sekaligus dapat 

digunakan untuk pembelajaran mandiri. Tulisan ini mengulas langkah praktis dan mudah 

membuat suatu media presentasi yang efektif dan interaktif yang dapat mendukung 

keterlibatan interaksi siswa dan guru menjadi efektif dan tercapainya tujuan pembelajaran 

yang telah ditetapkan. 

 

Kata Kunci: PowerPoint, Bahan Ajar Interaktif, Macro Visual Basic 

 

 

 

 

A. PENDAHULUAN  

Perkembangan teknologi memiliki dampak pada berbagai bidang kehidupan 

manusia. Hampir seluruh kegiatan manusia sekarang ini tidak lepas dari  penggunan 

teknologi. Salah satu pemanfaatan teknologi bagi kehidupan manusia adalah 

pemanfaatan teknologi untuk pendidikan. Teknologi digunakan dalam dunia pendidikan 

sebagai media untuk menyampaikan informasi dalam pembelajaran. Pemanfaatan 

teknologi untuk pendidikan misalnya penggunanan  kertas, mesin cetak, radio, video 

taperecorder, film, televisi, overhead projector (OHP), dan komputer baik dalam bentuk 

computer assisted instruction (CAI), computer based instruction (CBI) maupun E-
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learning. Pada hakikatnya alat-alat tersebut tidak dibuat khusus untuk keperluan 

pendidikan, akan tetapi alat-alat tersebut ternyata dapat dimanfaatkan dalam proses 

pendidikan, bahkan dapat meningkatkan efektivitas, efisiensi dan kualitas hasil 

pembelajaran. 

Guru sebagai fasilitator dalam pembelajaran dituntut untuk memiliki kemampuan 

menguasai teknologi. Dengan penguasaan teknologi, maka guru dapat menyampaikan 

informasi dalam pembelajaran. Salah satu penggunaaan teknologi dalam pembelajaran 

adalah penggunaan teknologi sebagai media. Media pembelajaran merupakan sarana 

dalam pembelajaran agar pembelajaran dapat berjalan baik sesuai dengan tujuannya. 

Media  pembelajaran dapat pula diartikan sebagai sarana agar informasi yang akan 

disampaikan dalam pembelajaran bisa tersampaikan. Media pembelajaran yang baik 

dapat mempermudah informasi yang sulit dipahami, kompleks atau sulit dicerna dapat 

muda dimengerti oleh peserta didik.  

Teknologi yang bia digunakan sebagai media pembelajaran adalah penggunaan 

komputer. Komputer merupakan suatu perangkat pengolah data yang dapat didesain 

dikembangkan untuk membantu manusia menjalankan aktivitasnya. Komputer telah 

banyak digunakan dalam berbagai aspek kehidupan manusia. Perubahan yang cepat atau 

revolusi teknologi komputer telah membantu meringankan tugas-tugas dan pekerjaan 

manusia. Komputer tidak lagi hanya untuk keperluan komputasi saja, tetapi lebih dari itu 

dapat digunakan untuk keperluan mengolah data, menyimpan data dan penyajian 

(presentasi) data dan informasi.  

Penggunaan teknologi komputer yang dapat dirasakan dalam pembelajaran adalah 

dalam penggunaan komputer untuk proses belajar seperti presentasi mengajar. Presentasi 

mengajar menggunakan komputer menimbulkan rasa senang karena peserta didik merasa 

senang. Rasa senang yang dialami peserta didik karena dalam komputer menyediakan 

aplikasi-aplikasi yang bagus dan menarik sehingga peserta didik tidak cepat bosan, 

sebaliknya justru merangsang peserta didik ingin mengerti lebih banyak lagi.  Dengan 

tertariknya dan senangnya siswa dalam proses belajar diharapkan peserta didik  menjadi 

lebih unggul dibidangnya, lebih cerdas dan lebih mampu melihat persoalan dari segi lain, 

kini dan akan datang.  

Agar pemanfaatan komputer dapat maksimal digunakan dalam pembelajaran, 

maka perlu bagi seorang guru untuk tidak gagap teknologi (gaptek). Guru perlu memiliki 

kompetensi terhadap Teknologi Informasi Komputer (TIK). Kompetensi dapat diartikan  

sebagai  pengetahuan, keterampilan, dan nilai-nilai dasar yang direfleksikan dalam 

kebiasaan berfikir dan bertindak. Arti lain dari kompetensi adalah spesifikasi dari 

pengetahuan, keterampilan, dan sikap yang dimiliki seseorang serta penerapannya 

didalam  pekerjaan sesuai dengan standar kinerja yang dibutuhkan oleh lapangan. 

Dengan demikian kompetensi yang dimiliki oleh setiap guru akan menunjukan kualitas 

guru yang sebenarnya. Kompetensi terus akan terwujud dalam bentuk penguasaan 

pengetahuan, keterampilan, maupun sikap profesional dalam memajukan fungsi sebagai 

guru. Berdasarkan pengertian tersebut, Standar Kompetensi Guru adalah suatu 

pernyataan tentang kriteria yang dipersyaratkan, ditetapkan, dan disepakati bersama 

dalam bentuk penguasaan pengetahuan, keterampilan, dan sikap bagi seorang tenaga 
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kependidikan sehingga layak disebut kompeten (Departemen Pendidikan  Nasional, 

2004) 

Penguasaan Teknologi Informasi dan komputer merupakan bagian dari tuntutan 

seorang guru. Pada Peraturan Pemerintah (PP) Nomor 74 Tahun 2008 tentang Guru, 

menyatakan bahwa “Kompetensi guru meliputi kompetensi pedagogik, kompetensi 

kepribadian, kompetensi sosial, dan kompetensi profesional yang diperoleh melalui 

pendidikan profesi”. Aspek-aspek  kompetensi yang harus dimiliki (dipenuhi) guru, yang 

berkaitan dengan TIK adalah  pada kompetensi pedagogik : “ pemanfaatan teknologi 

pembelajaran”, dan pada kompetensi sosial : “ menggunakan teknologi komunikasi dan 

informasi secara fungsional”. Dengan demikian, penguasaan (pemanfaatan) TIK oleh 

guru dalam pembelajaran sangat penting.  

Dengan penguasaan TIK oleh guru maka guru dapat memanfaatkan Komputer 

untuk media pembelajaran. Aplikasi-aplikasi yang ada pada teknologi khusunya 

komputer dapat memfaslilitasi guru dalam membuat media pembelajaran. Salah satu 

aplikasi dalam komputer yang bisa digunakan sebagai media pembelajaran adalah 

penggunaan media Powerpoint. Microsoft PowerPoint adalah salah satu jenis program 

komputer yang tergabung dalam Microsoft Office. Microsoft PowerPoint merupakan 

program aplikasi yang digunakan untuk presentasi. Aplikasi ini banyak digunakan, 

apalagi oleh kalangan pebisnis, perkantoran, para pendidik, siswa, dan trainer. Seperti 

yang dikemukakan Asih Widi Harini (2011:1), PowerPoint adalah aplikasi untuk 

menyusun presentasi. Aplikasi ini sangat populer dan banyak digunakan oleh berbagai 

kalangan, baik profesional, akademisi, praktisi maupun pemula untuk aktivitas 

presentasi.  

Menurut Muhroghibi (2011) secara teoritis, sejauh ini Microsoft PowerPoint di 

dalam pembelajaran memiliki beberapa kelebihan diantaranya : (a) penyajiannya menarik 

karena ada permainan warna, huruf dan animasi, baik animasi teks maupun animasi 

gambar atau foto. (b) lebih merangsang anak untuk mengetahui lebih jauh informasi 

tentang bahan ajar yang tersaj, (c)  pesan informasi secara visual mudah dipahami peserta 

didik. (d) guru tidak perlu banyak menerangkan bahan ajar yang sedang disajikan, 

(f)  dapat diperbanyak sesuai kebutuhan, dan dapat dipakai secara berulang-ulang, (g) 

dapat disimpan dalam bentuk data optik atau magnetik. (CD / Disket/Flashdisk), sehingga 

paraktis untuk di bawa ke mana-mana. 

Powerpoint merupakan media yang menarik untuk pembelajaran. Aplikasi 

Powerpoint sangat familiar dikalangan pendidik dalam melakukan presentasi 

pembelajaran. Namun penggunaan Powerpoint oleh guru kurang menarik lagi karena 

pembuatannya yang sangat sederhana tanpa adanya desain yang menarik dan interaktif 

yang mampu membuat peserta lebih tertarik dan bisa belajar mandiri. Perlu pengetahuan 

teknologi yang lebih bagi seorang guru untuk lebih kreatif dalam pembuatan Powerpoint 

sebagai bahan media pembelajaran. Komputer menyediakan aplikasi yang mendukung 

pembuatan media pembelajaran yang lebih menarik dan atraktif agar media lebih efektif.  

Aplikasi yang mendukung dalam pembuatan Powerpoint yang lebih menarik dan 

atraktif adalah penggunaan Macro Visual Basic.  Dalam makalah ini akan dibahas 

bagaimana langkah membuat media pembelajaran berupa presentasi yang menarik, 

efektif dan interaktif. 

http://id.shvoong.com/authors/muhroghibi/
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B. PEMBELAJARAN MELALUI PRESENTASI 

Pembelajaran adalah proses pemberian informasi. Salah satu metode yang 

digunakan oleh guru dalam pembelajaran adalah presentasi. Presentasi adalah suatu 

kegiatan berbicara di hadapan banyak hadirin. Berbeda dengan pidato yang lebih sering 

dibawakan dalam acara resmi dan acara politik, presentasi lebih sering dibawakan dalam 

acara bisnis atau promosi. Presentasi berdasarkan Kamus Besar Bahasa Indonesia berarti 

menyajikan atau mengemukakan. Atau secara jelasnya presentasi bisa diartikan 

menyajikan atau mengemukakan informasi kepada orang lain dengan tujuan bermacam-

macam seperti, memberi tahu, mempengaruhi ataupun mengajak (persuasif). Namun 

demikian pada saat ini presentasi juga dilakukan dalam proses pembelajaran, baik yang 

dilakukan oleh guru maupun peserta didik. 

Tujuan dari presentasi adalah ; (1) Menyampaikan informasi. Banyak pendidik 

dan peserta didik yang melakukan presentasi hanya bertujuan menyampaikan informasi 

saja. Informasi/pesan yang disampaikan bisa bersifat biasa, penting atau bahkan rahasia. 

Melalui informasi maka diharapkan tujuan dari proses pembelajaran dapat tercapai. Oleh 

karena itu seorang baik secara individu maupun mewakili kelompoknya harus memiliki 

keahlian sesuai dengan tujuan presentasi. Dalam proses pembelajaran, informasi dari 

seorang presentasi sangat penting bagi warga kelas. (2).Meyakinkan pendengar. 

Presentasi yang dilakukan berisikan informasi-informasi, data-data dan bukti-bukti yang 

disusun secara logis sehingga informasi yang disampaikan dapat membuat seseorang atau 

kelompok orang merasa yakin. Semula yang asalnya memiliki unsur ketidakjelasan dan 

ketidakpastian sehingga ketika diadakan presentasi oleh pembicara, seseorang/kelompok 

orang tersebut menjadi yakin atas informasi yang diberikan. Misal ketika seorang guru 

atau sekelompok peserta didik melakukan presentasi kelompok, maka peserta didik yang 

lain menjadi lebih yakin dengan materi yag sedang dipelajari. (3 ) Menghibur pendengar. 

Pada era globalisasi ini banyak acara-acara hiburan pada penayangan televisi. Acara 

hiburan tersebut dipimpin oleh presenter yang handal, tujuannya untuk menghibur para 

penonton. Prensenter dituntut untuk melakukan pembicaraan yang sifatnya menghibur 

tetapi relevan dan profesional sehingga para penonton televisi dapat menikmati acara 

tersebut. Selain acara televisi, acara hiburan yang lainnya dapat kita temukan pada pesta 

perayaan-perayaan. Contoh: pesta perayaan pernikahan, ulang tahun dan lain-lain. 

Presenter ditugaskan untuk berbicara dan menyelipkan kata-kata yang dapat menghibur 

para tamu yang hadir pada pesta perayaan tersebut. Sedikit berbeda dengan presentasi 

yang dilakukan di dalam kelas, seorang presenter tidak harus menggunakan kata-kata 

yang bersifat menghibur aka tetapi bisa cukup dengan kata-kata yang komunikatif. Untuk 

lebih menghibur penonton agar tidak mudah jenuh, maka jika presentasi dilengkapi 

dengan media gambar maka suasananya akan lebih tertolong. (4). Memotivasi dan 

menginspirasi pendengar untuk melakukan suatu tindakan.  

Demi tercapainya suatu tujuan pembelajaran, seorang guru dituntut untuk 

mengarahkan dan membimbing para peserta didiknya agar dapat belajar secara maksimal 

dan tidak lupa untuk memperhatikan kualitas belajarnya. Selain diberi arahan dan 

bimbingan, seorang guru  juga dapat melakukan motivasi agar para peserta didiknya 

dapat belajar dengan semangat yang tinggi. Kegiatan memotivasi tersebut dapat 

http://id.wikipedia.org/wiki/Pidato
http://id.wikipedia.org/wiki/Politik
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dilakukan dengan mengadakan suatu forum. Forum tersebut terdiri dari para peserta 

didiknya yang bertindak sebagai pendengar, sedangkan yang bertindak sebagai 

pembicara yaitu pihak guru atau peserta maupun sekelompok peserta didiknya yang 

sudah diberi arahan oleh guru. (5). Menyampaikan pesan. 

Tujuan presentasi yang kelima  yaitu menyampaikan pesan. Hal ini dilakukan 

karena proses pembelajaran bukan sekedar transfer ilmu pengetahuan dari seorang guru 

atau sekelompok peserta didik kepada warga kelas, akan tetapi juga sarana untuk 

menyampaikan pesan moral. Guru atau peserta didik yang melakukan presentasi dibantu 

dengan alat bantu peraga ataupun media untuk memudahkan penyampaian pesan. (6). 

Membuat suatu ide atau gagasan. Presentasi yang dilakukan hanya bertujuan untuk 

memunculkan suatu ide/gagasan dari para peserta pendengar. Tipe tujuan ini biasanya 

diterapkan pada materi pelajaran yang memerlukan pemecahan atau solusi dari orang 

lain. Forum yang dilakukan sering dikenal dengan istilah diskusi. (7). Menyentuh emosi 

pendengar. Tujuan yang ketujuh yaitu untuk menyentuh emosi para peserta didik. Dalam 

hal ini pembicara atau presenter bertugas untuk melakukan pembicaraannya yang dapat 

menyentuh perasaaan/emosi seseorang. Sebagai contoh pembicara melakukan presentasi 

kepada para pendengar mengenai korban bencana, demonstrasi, kelaparan, gelandangan, 

tuna pendidikan dan lain-lain. resentasi yang dilakukan pembicara membuat pendengar 

merasa tersentuh untuk membantu para korban bencana dengan cara menyumbangkan 

sebagian hartanya. (8).Memperkenalkan diri. Presentasi juga dapat ditujukan hanya 

sekedar untuk memperkenalkan jati diri bagi yang melakukan presentasi, baik secara 

individual maupun kelompok. 

 

C. MEDIA PEMBELAJARAN 

Dalam melakukan presentasi dibantu oleh media. Pengertian media mula-mula 

dikenal dengan alat peraga, kemudian dikenal dengan istilah audio visual aids (alat bantu 

pandang/dengar). Selanjutnya disebut instructional materials (materi pembelajaran), dan 

kini istilah yang lazim digunakan dalam dunia pendidikan nasional adalah instructional 

media (media pendidikan atau media pembelajaran). Penggunaan Media dalam 

pembelajaran  adalah dalam  upaya peningkatan atau mempertinggi mutu proses kegiatan 

belajar-mengajar. Beberapa persyaratan yang harus dipenuhi dalam pemilihan media 

dalam pembelajaran adalah (1) media pengajaran yang digunakan harus sesuai dengan 

tujuan pembelajaran yang telah ditetapkan. (2) media pengajaran tersebut merupakan 

media yang dapat dilihat atau didengar, (3) media pengajaran yang digunakan dapat 

merespon peserta didik, (4) media pengajaran juga harus sesuai denga kondisi individu 

peserta didik, (5) media pengajaran tersebut merupakan perantara (medium) dalam proses 

pembelajaran peserta didik. 

Media belajar dapat digolongkan  menjadi beberapa jenis jika dilihat dari berbagai 

sudut pandang  yaitu : (1). dilihat dari jenisnya media dapat digolongkan menjadi 

mediaaudio, media visual dan media audio isual . (2). dilihat dari gaya liputnya media 

dapat digolongkan menjadi media dengan daya liput luas dan serentak, media dengan 

daya liput yang terbatas dengan ruang dan tempat dan mediapengajaran individual. (3). 

dilihat dari bahan pembuatannya media dapat digolongkan menjadi media sederhana 
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(murah dan mudah memperolehnya) dan media komplek. (4). dilihat dari bentuknya 

media dapat digolongkan menjadi media grafis (dua dimensi, media tiga dimensi dan 

media elektronik.  

Salah satu contoh media belajar audio visual tersebut adalah dengan 

menggunakan komputer atau yang lebih dikenal dengan media pembelajaran berbantuan 

komputer. Komputer adalah hasil dari  kemajuan teknologi elektronika dan informatika 

yang berfungsi sebagai alat bantu untuk menulis, menggambar, menyunting gambar atau 

foto membuat animasi, mengoperasikan program analisis ilmiah, simulasi dan untuk 

kontrol peralatan. Perkembangan teknologi komputer baik hardware maupun software 

saat ini sangat mendukung untuk mengembangkan model pembelajaran edutainment 

(education entertainment) sekaligus sebagai media pembelajarannya.  

 

D. MICROSOFT POWERPOINT 

Perkembangan teknologi  yang makin pesat menawarakan berbagai macam 

aplikasi dalam komputer  yang bisa digunakan dalam pembelajaran. Powerpoint 

merupakan salah satu media presentasi yang menarik. Media yang digunnakan dalam 

presentasi adalah media Powerpoint.  

Microsoft PowerPoint adalah suatu software yang akan membantu dalam 

menyusun sebuah presentasi yang efektif, professional, dan juga mudah. Media 

powerpoint  bisa  membantu  sebuah gagasan  menjadi lebih menarik  dan jelas tujuannya 

jika dipresentasikan karena media powerpoint akan membantu dalam pembuatan slide, 

outline presentasi, presentasi  elektronika, menampilkan slide  yang  dinamis, termasuk 

clipart yang menarik, yang semuanya itu mudah ditampilkan di layar monitor 

komputer. PowerPoint adalah alat bantu presentasi, biasanya digunakan untuk 

menjelaskan suatu hal yang dirangkum dan dikemas dalam slide PowerPoint. Sehingga 

pembaca dapat lebih mudah memahami penjelasan kita melalui visualisasi yang 

terangkum di dalam slide. 

Kemudahan yang didapat dari penggunaan Powerpoint untuk media presentasi 

adalah (1) dapat menyimpan banyak waktu untuk orang yang dinyatakan akan digunakan 

jenis lain visual bantuan-tangan yang ditarik atau mekanis mengeset slide, papan tulis 

atau proyeksi overhead. (2) kemudahan penggunaan juga mendorong mereka yang 

dinyatakan tidak akan menggunakan alat bantu visual, atau tidak akan memberikan 

presentasi sama sekali, untuk membuat presentasi. 

Keunggulan Powerpoint yaitu salah satu fitur menyediakan kemampuan untuk 

membuat presentasi yang meliputi musik yang memainkan seluruh presentasi atau efek 

suara untuk slide tertentu. Selain kemampuan untuk menambahkan file suara, presentasi 

dapat dirancang untuk berjalan, seperti film, sendiri. Powerpoint memungkinkan 

pengguna untuk merekam slide show dengan narasi dan laser pointer. Pengguna dapat 

menyesuaikan tampilan slide untuk menampilkan slide dalam urutan yang berbeda dari 

awalnya dirancang dan memiliki slide muncul beberapa kali. Microsoft juga menawarkan 

kemampuan untuk menyiarkan presentasi untuk pengguna tertentu melalui link dan 

Windows Live. Dan kelebihan yang lain dari powerpoint adalah sebagai berikut ; (1) 

praktis, dapat dipergunakan untuk semua ukuran kelas, (2) memberikan kemungkinan 
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tatap muka dan mengamati respons siswa (3) memiliki variasi teknik penyajian yang 

menarik dan tidak membosankan (4) dapat menyajikan berbagai kombinasi clipart, 

picture, warna, animasi dan suara sehingga membuat siswa lebih tertarik (5) dapat 

dipergunakan berulang-ulang. 

Dari kelebihan yang ada pada media Powerpoint maka hampir semua kalangan 

telah menggunakan Powerpoint. Namun teknologi makin berkembang, Perkembangan 

teknologi menawarkan powerpont dengan tampilan yang lebih menarik yaitu adanya 

program makro Visual Basic Application. Menurut kamus wikipedia Microsoft Visual 

Basic for Applications (VBA) adalah sebuah turunan bahasa pemrograman Visual 

Basic yang dikembangkan oleh Microsoft dan dirilis pada tahun 1993, atau kombinasi 

yang terintegrasi antara lingkungan pemrograman (Visual Basic Editor) dengan bahasa 

pemrograman (Visual Basic) yang memudahkan user untuk mendesain dan membangun 

program Visual Basic dalam aplikasi utama Microsoft Office, yang ditujukan untuk 

aplikasi-aplikasi tertentu. VBA didesain untuk melakukan beberapa tugas, seperti halnya 

mengkustomisasi sebuah aplikasi layaknya Microsoft Office atau Microsoft Visual 

Studio. Kegunaan VBA adalah mengotomatisasi pekerjaan. Pekerjaan yang dimaksud 

adalah pekerjaan yang dilakukan secara berulang-ulang dan pekerjaan yang kompleks. 

VBA berbeda dengan Microsoft Visual Basic, Microsoft Visual Basic memberi banyak 

pemrograman dan fungsi tingkat lanjut hingga Microsoft Visual Basic dapat dihasilkan 

program yang lebih kompleks untuk sistem operasi Microsoft Windows maupun Office. 

Sedangkan VBA hanya dapat dibangun pada aplikasi utama Microsoft Office 

mengendalikan fungsi aplikasi tersebut melakukan serangkaian objek terprogram. Versi 

VBA terbaru saat ini adalah versi 6.3 yang dirilis pada tahun 2001, yang mendukung 

semua program dalam Microsoft Office, yakni Microsoft Excel, Microsoft 

Access, Microsoft Word, Microsoft Outlook, Microsoft FrontPage, serta Microsoft 

PowerPoint dan juga Microsoft Visual Studio. 

Dengan macro visual basic application maka tampilan Powerpoint akan lebih 

menarik dan atraktif. Dalam Visual basic Aplication maka pengguna dapat ikut 

berinteraksi. Berbeda dengan point biasa yang tanpa memanfaatkan macro Visual Basic 

Aplication. Pada powerpoint tanpa menggunakan macro Visual Basic Aplikation maka 

pembelajaran hanya searah, artinya siswa hanya bisa melihat tampilan slide tanpa 

melakukan umpan balik atau berinteraksi langsung dengan pembelajaran yang sedang 

ditayangkan dalam media.  

Macro pada dasarnya adalah sebuah perintah khusus atau jalan pintas untuk 

memproses serangkaian tindakan.  Powerpoint dengan macro Visual Basic Aplication 

menawarkan bentuk simulasi sehingga pembelajaran lebih efektif, menarik, dan 

interaktif.  Aplikasi Visual Basic (VBA) untuk Microsoft Office Powerpoint selama ini 

banyak digunakan untuk membuat soal evaluasi, di mana nilai siswa akan muncul 

otomatis ketika selesai mengerjakan soal. Ternyata, masih banyak sekali kedahsyatan 

Aplikasi Visual Basic (VBA) untuk Microsoft Office Powerpoint yang masih belum 

tersentuh. Di antaranya dengan VBA kita bisa membuat berbagai simulasi menarik. 

Simulasi untuk matematika dan fisika di antaranya (a) menghitung luas bangun datar, (b) 

menghitung keliling bangun datar, (c) menghitung jarak, kecepatan, dan waktu pada 

gerak, (d) menghitung besarnya massa jenis, massa, maupun volume benda.  

https://id.wikipedia.org/wiki/Visual_Basic
https://id.wikipedia.org/wiki/Visual_Basic
https://id.wikipedia.org/wiki/Microsoft
https://id.wikipedia.org/wiki/1993
https://id.wikipedia.org/wiki/Microsoft_Office
https://id.wikipedia.org/wiki/Microsoft_Visual_Studio
https://id.wikipedia.org/wiki/Microsoft_Visual_Studio
https://id.wikipedia.org/wiki/Microsoft_Excel
https://id.wikipedia.org/wiki/Microsoft_Access
https://id.wikipedia.org/wiki/Microsoft_Access
https://id.wikipedia.org/wiki/Microsoft_Word
https://id.wikipedia.org/wiki/Microsoft_Outlook
https://id.wikipedia.org/wiki/Microsoft_FrontPage
https://id.wikipedia.org/wiki/Microsoft_PowerPoint
https://id.wikipedia.org/wiki/Microsoft_PowerPoint
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Dengan menguasai program macro Visual Basic Aplication khususnya untuk 

Powerpoint maka media presentasi yang dihasilkan akan lebih menarik. Dan sudah 

seharusnya guru sebagai fasilitator dalam pembelajaran untuk belajar teknologi agar 

mampu membuat media yang efektif, menarik dan interaktif dengan tujuan pembelajaran 

dapat berjalan lancar tanpa rasa bosan  pada siswa sehingga tujuan pembelajaran dapat 

lebih mudah dicapai. Macro Visual Basic Application Powerpoint merupakan  alternatif 

pilihan dalam pemilihan media pembelajaran.  

 

E. LANGKAH PRAKTIS 

Langkah-langkah praktis pembuatan media presentasi yang efektif dan interaktif 

dalam pembelajaran dapat dilakukan melalui tahapan berikut ini: 

1. Menyiapkan  Slide 

a) menonaktifkan klik sembarang tempat / tombol, menekan mouse atau keyboard 

dalam membuat slide bahan ajar interaktif. 

 
b) dengan menekan tombol yang dibuat / disiapkan, slide hanya akan berpindah ke 

slide lainnya. 

c) cara menonaktifkan adalah: klik “Slide Show” > “Set up Slide Show” > Pilih 

“Browsed at a kiosk (full screen)” > OK. 

d) copy slide yang sudah dinonaktifkan sebanyak slide yg diperlukan. 

e) beri judul masing2 slide dengan: HOME, AUTHOR, SK/KD, INDIKATOR, 

MATERI, EVALUASI 
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HOME

AUTHOR

SK / KD

INDIKATOR

MATERI

EVALUASI

AUTHOR

DJOKO SRI BIMO

   

2. Menyiapkan Tombol 

 buat tombol menggunakan Shapes Rectangle, beri warna dan efek 

 

 Atur posisi menggunakan menu Home > Arrange > Align, sehingga tertata 

seperti gambar di bawah.  

 

 Klik masing2 tombol, 

pilih menu Insert > 

Action > centang 

Highlight pada Mouse 

Click & Mouse Over, 

kecuali pada nama slide 

& tombol yg sama. 

 Copy tombol2 tsb ke 

semua slide, beri warna 

beda pada slide yang sama 

dengan tombolnya 

 

 
3. Menyiapkan Hyperlynk 

Adalah menghubungan Tombol ke slide-slide yang sesuai. 

- Tombol Author  Slide Author 

- Tombol SK/KD  Slide SK/KD 
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      - Tombol Indikator  Slide Indikator 

- Tombol Materi  Slide Materi  

- Tombol Evaluasi  Slide Evaluasi  

 Pilih tombol Author pada slide HOME 

 Mengapa langsung memilih tombol “Author” dan tidak memilih tombol “Home” 

untuk dibuat hyperlink? 

 Karena pada saat ini Anda sedang berada pada slide 1 dengan judul “Home”, jadi 

tidak perlu hyperlink dari “Home” ke “Home” kecuali dari slide lainnya (slide 2 

dst).  

 Klik menu Insert > Hyperlink > Hyperlink to Author 

 

 

 

 Dengan cara yang sama lakukan untuk tombol SK/KD dan seterusnya. 

 

4. Membuat Soal dengan Macro VBA (Visual Basic Applications) 

 Aktifkan menu “ Developer dengan cara : klik Office button > Powerpoint options 

> centang Show developer tab in the Ribbon. 

 

Contoh Desain evaluasi sederhana untuk 

10 soal evaluasi 

 
 

 Pada Slide 1 buat tombol Mulai menggunakan Shapes > Action Button.  

 Buat Macronya: Developer > Macros > Mulai > Create 

 Tulis script yang ada dalam lingkaran di bawah ini: 
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 Pilih tombol Mulai   > Insert > Action > klik Run macro > pilih mulai > 

OK. 

 
 Pada Slide 2 dst (tempat Soal 1 dst) buat tombol Next menggunakan Shapes > 

Action Button. 

 Buat Macronya: Developer > Macros > Lanjut > Create 

 Klik 2 kali button tersebut, buat script seperti dalam lingkaran sebagai berikut : 

 
 Buat soal 1 dst beserta tombol pilihan (A,B,C,D,E) untuk kotak jawaban dengan 

menggunanakan Shape > Action Button > Custom 
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 Dan seterusnya. 

 Buat Macro Jawaban benar: Developer > Macros > JwbBenar > Create, tulis 

script seperti di bawah ini. 

               
 Dengan cara yg sama buat Macro untuk Jawaban salah, dan scriptnya : 

 
 Klik tombol Jawaban: Insert > Action Settings > klik Run Macro > pilih 

JwbBenar untuk tombol yg jawabannya benar, dan pilih JwbSalah untuk tombol 

yg jawabannya salah. 
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Lakukan hal yg sama pada semua soal 

 

 

Di slide terakhir setelah soal selesai, Buat tombol CEK menggunakan menu 

Developer > Controls > Command Button   

 
 Klik menu Developer > Visual Basic > Insert > User Forms, akan muncul 

tampilan seperti di bawah ini:  

  
 

 

 Buat kotak di samping kanannya 

menggunakan Text Box pada 

Toolbox 

 
 Pengaturan huruf dan warna pada User Form: klik kanan > Properties  

 Klik 2 kali tombol “CEK,” tuliskan script sbb: 
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 Coba di Slideshow, klik tombol 

“Hasil Nilai” akan tampil : 

 
 

5. Membuat Skor   

 Klik 2 kali tombol CEK, tulis script: 

 
 Coba hasilnya (F5), kerjakan soal dan cek nilainya. 

 Bila belum terisi jumlah benar dan salahnya, klik salah satu tombol Action, 

masuk Macro, ketik script di baris paling atas seperti pada lingkaran atas, dan 

beri tanda petik di depan perintah Dim seperti lingkaran bawah: 

 

 
 Coba kerjakan soal yang ada dengan mencoba menjawab semua option/tombol. 

 Bagaimana hasilnya? 

 Supaya hanya bisa sekali jawab gmn? 

 

6. Mengatur Jawaban Sekali Klik 

 Buat Shapes Rectangle (warna putih, transparan, no line)  

 Letakkan di atas tombol A B C D 
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 Pilih Rectangle > Animation > Custom Animation > Add Effect > Entrance > 

Appear 

 
 Klik Timing > Trigger > Start effect on click of tombol A 

 
 Pilih lagi Rectangle > Add Effect > Entrance > Appear 

 Klik Timing > Trigger > Start effect on click of tombol B 

 Dan seterusnya sampai tombol D 

 Kopi ke smua slide soal, setting Triggernya ke semua tombol A B C D 
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7. Menyimpan File 

 File disimpan dalam format *.pptm  (Powerpoint Macro-Enabled Presentation) 

 
(http://www.vedcmalang.com/pppptkboemlg/index.php/menuutama/teknologi-

informasi/477-bai-ppt.) 

 

F. PENUTUP 

Kemajuan teknologi merambah pada berbagai bidang kehidupan manusia, salah 

satunya adalah masuknya teknologi pada dunia pendidikan. Penggunaan teknologi pada 

dunia pendidikan sebenarnya sudah lama yaitu dengan adanya OHP, video, tape 

recorder, film dan sebagainya yang semua itu bisa digunakan dalam pembelajaran . 

Seiring dengan teknologi yang berkembang  semakin pesat  menuntut guru sebagai 

fasilitator dalam pembelajaran untuk tidak gagap teknologi.  Teknologi yang makin 

canggih bisa dimanfaatkan oleh guru atau pendidik sebagai media dalam pembelajaran. 

Media itu sendiri adalah sarana atau alat yang bisa digunakan sebagai sarana dalam 

penyampaian informasi. Media terdiri dari media visual, audio dan audiovisual. Dengan 

penggunaan media maka pembelajaran akan lebih bisa diterima oleh peserta didik.  

Sesuai dengan karakteristik media, maka media dapat menjadi sarana penyampaian 

informasi. Informasi yang diberikan oleh guru kepada peserta didik yaitu metode 

presentasi, sedangkan presentasi itu sendiri akan lebih menarik jika menggunakan media.  

Dengan adanya komputer yang menawarkan berbagai macam aplikasi, maka salah 

satu aplikasi yang bisa digunakan untuk media pembelajaran adalah macro Visual Basic 

Application Powerpoint. Macro VBA Powerpoint menawarkan program yang bisa 

digunakan sebagai media pembelajaran yang menarik, efektif dan interaktif. Dengan 

http://www.vedcmalang.com/pppptkboemlg/index.php/menuutama/teknologi-informasi/477-bai-ppt
http://www.vedcmalang.com/pppptkboemlg/index.php/menuutama/teknologi-informasi/477-bai-ppt
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Macro VBA Powerpoint maka pembelajaran akan lebih menarik, interaktif dan efektif, 

artinya pesan bisa tersampaikan pada peserta didik tanpa menimbulkan kebosanan dan  

peserta didik bisa ikut interaksi dalam pembelajaran melalui media tersebut.  

Sudah seharusnya  kemajuan teknologi bisa dimanfaatkan oleh seluruh manusia 

untuk mempermudah pekerjaan, khususnya guru sebagai pendidik agar  tujuan 

pembelajaran bisa tercapai. Dengan tujuan pembelajaran dapat tercapai, secara moral 

tanggungjawab guru akan menjadi seorang guru yang benar-benar profesional sesuai 

dengan harapan pemerintah. 
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